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[bookmark: _Toc51256742]Purpose
This scope item describes the processes you perform to prevent system breakdowns or breakdowns of objects that have high repair costs. Such breakdowns result in greater costs due to production downtime. Preventive maintenance supports processes to plan the scope and time of maintenance work for inspections, maintenance, and repairs, in advance. The quality of products manufactured is substantially affected by the operational condition of the production plant. There is a requirement for quality assurance to be more cost effective to maintain objects regularly, and in return, avoid a more expensive breakdown. You determine the data required for preventive maintenance by using previous data supplied by the system. In addition to internal company aspects for planned maintenance, you should consider external factors due to an increasing number of conditions set by legislative bodies demanding more stringent requirements on planned monitoring and maintenance of objects.You can also have a role-based and personalized entry page for maintenance planners to monitor the progress of various maintenance activities that impact asset availability and reliability.
This document provides a detailed procedure for testing this scope item after solution activation, reflecting the predefined scope of the solution. Each process step, report, or item is covered in its own section, providing the system interactions (test steps) in a table view. Steps that are not in scope of the process but are needed for testing are marked accordingly. Project-specific steps must be added.
[bookmark: unique_2][bookmark: _Toc51256743]Prerequisites
This section summarizes all the prerequisites for conducting the test in terms of systems, users, master data, organizational data, other test data and business conditions.
[bookmark: unique_3][bookmark: _Toc51256744]System Access
	System
	Details

	System
	Accessible via SAP Fiori launchpad. Your system administrator provides you with the URL to access the various apps assigned to your role.


[bookmark: unique_4][bookmark: _Toc51256745]Roles
Assign the following business roles to your individual test users. Alternatively, if available, you can create business roles using the following spaces with pages and predefined apps for the SAP Fiori launchpad and assign the business roles to your individual test users.
Note These roles or spaces are examples provided by SAP. You can use them as templates to create your own roles or spaces.
For more information about business roles, refer to Assigning business roles to a user in the Administration Guide to Implementation of SAP S/4HANA with SAP Best Practices .
	Name (Role)
	ID (Role)
	Description (Space)
	ID (Space)
	Log On

	Maintenance Planner
	SAP_BR_MAINTENANCE_PLANNER
	Maintenance Planning
	SAP_BR_MAINTENANCE_PLANNER
	

	Maintenance Technician
	SAP_BR_MAINTENANCE_TECHNICIAN
	Maintenance Execution
	SAP_BR_MAINTENANCE_TECHNICIAN
	

	Inventory Manager
	SAP_BR_INVENTORY_MANAGER
	Inventory Management
	SAP_BR_INVENTORY_MANAGER
	


[bookmark: unique_5][bookmark: _Toc51256746]Master Data, Organizational Data, and Other Data
The organizational structure and master data of your company has been created in your system during activation. The organizational structure reflects the structure of your company. The master data represents materials, customers, and vendors, for example, depending on the operational focus of your company.
Use your own master data or the following sample data to go through the test procedure.
	Data
	Sample Value
	Details
	Comments

	Maintenance Plant
	1010
	Plant 1 DE
	

	Storage Location
	101B
	Std. storage 2
	

	Material
	SP001
	Bearing
	Spare Parts

	Material
	SP002
	Coupling
	Spare Parts

	Material
	SP003
	Shaft
	Spare Parts

	Material
	SP004
	Gaskets 1mm
	Spare Parts

	Material
	SP005
	Mechanical Seal
	Spare Parts

	Material
	SP006
	Spur gear IS651
	Spare Parts

	Work Center
	RES-0100
	Mechanics
	

	Work Center
	RES-0200
	Electric
	

	Work Center
	RES-0300
	Instrumentation
	

	Characteristics
	OPERATING_HOUR
	Hour Meter Reading
	

	Characteristics
	PRESSURE
	Pressure Reading
	

	Counter Measuring Point
	XXXXXX
	Operating Hour
	1-999999

	Non Counter Measuring Point
	XXXXXX
	Pressure Guage
	1-999999

	Functional Location
	1010-XXX-XXX-XXXXX-XXXX-XXXX
	
	1010 and the substructures

	Equipment
	21010XXXX
	
	210100001 ~210100092

	Equipment BOM
	210100091
	
	With SP001 ~ SP006 assigned


[bookmark: unique_6][bookmark: _Toc51256747]Business Conditions
Before this scope item can be tested, the following business conditions must be met.
	Scope Item
	Business Condition

	BNZ - Create New Open MM Posting Period
	You have completed the step described in the Create New Open MM Posting Period (BNZ) master data script. The posting period is up to date.
To run through this scope item, the materials must be available in stock.


[bookmark: unique_7][bookmark: _Toc51256748]Initializing Material Stock
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In a real business case, the materials are usually purchased from external suppliers. In this case, the process is covered by the standard purchasing or subcontracting processes. This process step shows you how to post initial stock directly to the storage locations.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as an Inventory Manager.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Manage Stock (F1062).
	The Manage Stock screen displays.
	

	3
	Input Material
	Make the following entries and choose Enter:
1. Material: < material number>. Select one of the Spare Parts Material mentioned in the previous section Master Data, Organizational Data, and Other Data.
· Plant: Plant 1 DE (1010)
	
	

	4
	Select Stock
	Select the icon beside the stock that you want to add initial stock, for example:
1. Storage Location: Std. storage 2 (101B)
· Unrestricted-Use Stock
	A dialog box opens. The Storage Location, Stock Type and Current Quantity display according to your entries in the previous steps.
	

	5
	Add Initial Entry
	Make the following entries and choose Post:
1. Document Date: <today>
· Posting Date: <today>
· Stock Change: initial entry
· Quantity: <quantity number>
	The system displays Material document XXX created. The stock has been added.
	


[bookmark: unique_8][bookmark: _Toc51256749]Measuring Point Creation
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
Measuring points (counter) are created to be used in the same performance-based plans. The readings that are entered against these measuring points will be used for scheduling and determining the preventive maintenance dates.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Maintenance Planner.
	The SAP Fiori launchpad displays.
	

	2
	Open the App
	Open Create Measuring Point (EAMS_WDA_MP_OIF)
	The Create Measuring Point screen displays.
	

	3
	Input Details
	Make the following entries:
1. Measuring Point/Counter: Counter
· Reference Object Type: Technical Object
Under Reference Object section, make the following entries:
1. Technical Object: <Equipment/Floc No>
· Choose Continue.
	
	

	4
	Maintain General Data
	In the General Data section of the screen, make the following entries:
1. Description: <Description of Measuring Point>
· Measurement Position: <Name of Measuring Position>
· Characteristic: OPERATING_HOUR
· Measuring Point Category: M (MeasPoint General)
Enter the required details for Target Limits and Counter Data:
1. Overflow Reading: <Counter Overflow Reading>
· Annual Estimate: <Annual Estimate of Tech Object>
· Choose Save.
	The measuring point is created.
	


[bookmark: unique_9][bookmark: _Toc51256750]Overview Table
The scope item Preventive Maintenance consists of several process steps provided in the table below.
If your system administrator has enabled spaces and pages on the SAP Fiori launchpad, the homepage will only contain the essential apps for performing the typical tasks of a business role.
You can find all other apps not included on the homepage using the search bar.
If you want to personalize the homepage and include the hidden apps, navigate to your user profile and choose Settings > App Finder .
	Process Step
	Business Role
	Transaction/App
	Expected Results

	Preventive Maintenance - Time Based Single Cycle Plans

	Create General Task List  [page ] 13
	Maintenance Planner
	Create Task List
	The Create Task List page appears.

	Create Maintenance Plan  [page ] 16
	Maintenance Planner
	Create Maintenance Plan
	The Create Maintenance Plan page appears.

	Schedule Maintenance Plan  [page ] 19
	Maintenance Planner
	Schedule Maintenance Plans (F2774)
	The Schedule Maintenance Plan: Initial page appears.

	Preventive Maintenance - Time Based Strategy Plans

	Maintain Maintenance Strategies  [page ] 21
	Maintenance Planner
	Maintenance Strategies (IP12)
	The Display Maintenance Strategies: Overview page appears.

	Create General Task List  [page ] 23
	Maintenance Planner
	Create Task List
	The Create Task List page appears.

	Create Maintenance Plan  [page ] 27
	Maintenance Planner
	Create Maintenance Plan
	The Create Maintenance Plan page appears.

	Schedule Maintenance Plan  [page ] 29
	Maintenance Planner
	Schedule Maintenance Plans (F2774)
	The Schedule Maintenance Plan: Initial page appears.

	Preventive Maintenance - Performance Based Single Cycle Plan

	Create General Task List  [page ] 32
	Maintenance Planner
	Create Task List
	The Create Task List page appears.

	Create Maintenance Plan  [page ] 35
	Maintenance Planner
	Create Maintenance Plan
	The Create Maintenance Plan page appears.

	Create Measurement Document  [page ] 38
	Maintenance Planner
	Create Measurement Document
	The Create Measurement Document Page appears

	Schedule Maintenance Plan  [page ] 79
	Maintenance Planner
	Schedule Maintenance Plans (F2774)
	The Schedule Maintenance Plan: Initial page appears.

	Preventive Maintenance - Performance Based Strategy Plan

	Maintain Maintenance Strategies  [page ] 42
	Maintenance Planner
	Maintenance Strategies (IP12)
	The Display Maintenance Strategies: Overview page appears.

	Create General Task List  [page ] 44
	Maintenance Planner
	Create Task List
	The Create Task List page appears.

	Create Maintenance Plan  [page ] 48
	Maintenance Planner
	Create Maintenance Plan
	The Create Maintenance Plan page appears.

	Create Measurement Document  [page ] 50
	Maintenance Planner
	Create Measurement Document
	The Create Measurement Document Page appears

	Schedule Maintenance Plan  [page ] 52
	Maintenance Planner
	Schedule Maintenance Plans (F2774)
	The Schedule Maintenance Plan: Initial page appears.

	Preventive Maintenance - Multiple Counter Plan

	Create General Task List  [page ] 54
	Maintenance Planner
	Create Task List
	The Create Task List page appears.

	Create Maintenance Plan  [page ] 57
	Maintenance Planner
	Create Maintenance Plan
	The Create Maintenance Plan page appears.

	Create Measurement Document  [page ] 60
	Maintenance Planner
	
	

	Schedule Maintenance Plan  [page ] 61
	Maintenance Planner
	Schedule Maintenance Plans (F2774)
	The Schedule Maintenance Plan: Initial page appears.

	Preventive Maintenance - Order Processing

	Release Preventive Maintenance Order and Print to Job List  [page ] 63
	Maintenance Planner
	Manage Orders and Notifications in Information Center (W0019)
	The Order and Notification Information Center page appears.

	Print Job Card  [page ] 65
	Maintenance Technician
	Display Job List (W0016)
	The Job List page appears.

	Confirm Preventive Maintenance Order  [page ] 66
	Maintenance Technician
	Confirm Jobs (W0020)
	The Confirmation page displays.

	Create Follow-On Order  [page ] 68
	Maintenance Planner
	Manage Orders and Notifications in Information Center (W0019)
	The Order and Notification Information Center page displays.

	Show Costs on Preventive Maintenance Order  [page ] 72
	Maintenance Planner
	Manage Orders and Notifications in Information Center (W0019)
	The Order and Notification Information Center page appears.

	Technically Complete Preventive Maintenance Order  [page ] 73
	Maintenance Planner
	Manage Orders and Notifications in Information Center (W0019)
	The Order and Notification Information Center page appears.

	Review Document Flow of Preventive Maintenance Order  [page ] 74
	Maintenance Planner
	Display Maintenance Order (MaintenanceOrder-display)
	The Display Preventive Maintenance: xxxxxxx page appears.

	Review Asset Maintenance Object Pages  [page ] 75
	Maintenance Planner
	
	


[bookmark: unique_38][bookmark: _Toc51256751]Test Procedures
This section describes test procedures for each process step that belongs to this scope item.
[bookmark: d2e1185][bookmark: _Toc51256752]Time-Based Single Cycle Plan
[bookmark: unique_10][bookmark: _Toc51256753]Create General Task List
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
Using task lists, you can centrally define and manage maintenance tasks for your technical objects. General task lists can also help you to prepare maintenance plans and orders.
A task list group combines one or more task lists according to their logical features. Within a task list group, each task list is identified by a group counter. This enables you, for example, to combine several task lists in one group. Within the group, the system allocates a sequential number (the group counter) to each individual task list.
Prerequisites
1. Technical objects in the form of functional locations, equipment, and maintenance assemblies.
· Organizational units such as maintenance planners and work centers.
· Cost centers defined in the master data of the technical objects.
· Maintenance spare parts and assemblies in the MM (Materials Management) module.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori Launchpad as Maintenance Planner.
	The SAP Fiori Launchpad displays.
	

	2
	Open Create Task List
	Open Create Task List .
	The Create Task List page appears.
	

	3
	Choose Task List Type
	Choose Task List Type: General Maintenance Task List.
	The Create General Maintenance Task List screen displays.
	

	4
	Enter Creation Parameters
	Make the following entries and choose Continue.
1. Task List Group:
Comment: Task List Group uses internal number range.
· Planning Plant: 1010
· Group Counter:
Comment: The group counter would increase automatically if you create another task list under the same task list group.
· Status: Released (general)
· Select the relevant profile for the plant.
· Key Date: <Today>
Choose Continue.
	The Create General Maintenance Task List page displays.
	

	5
	Maintain General Data
	Make the following entries:
1. Description: <Description> Enter a description. For example, Mechanical Inspection.
· Status: Released (General)
· Planner Group: YB1
· Work Center: RES-0100
· Work Center Plant: 1010
· Assembly:
· System Condition: not in operation
Choose Operation Data.
	The Operation Data tab appears.
	

	6
	Maintain Operation Data
	Make the following entries and choose Enter.
1. Operation: 0010
· Description: Check the pump
· Work: 2
· Unit: H
· Capacities: 2
· Operation: 0020
· Description: Check the bearings
· Work: 1
· Unit: H
· Capacities: 1
· Operation : 0030
· Description: Check the coupling
· Work: 2
· Unit: H
· Capacities: 2
· Operation: 0040
· Description: Check the shaft
· Work: 3
· Unit: H
· Capacities: 3
Choose the Operation 0010.
In the lower part of the screen, Details: Operation 0010, Check the pump section, choose Materials.
Make the following entries and choose Enter.
1. Material: SP005
· Quantity: 1
Repeat the above step for other operations.
1. Operation Item: 0020
· Material: SP001
· Quantity: 2
· Operation Item: 0030
· Material: SP002
· Quantity: 1
· Operation Item: 0040
· Material: SP003
· Quantity: 2
Choose Save
	The general task list is created.
	


[bookmark: unique_11][bookmark: _Toc51256754]Create Maintenance Plan
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
Maintenance plan will have maintenance or inspection activities to be carried out for technical objects.
The frequency or strategy and, scope of the activities are defined in the maintenance plan.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad is displayed.
	

	2
	Open Create Maintenance Plan
	Open Create Maintenance Plan .
	The Create Maintenance Plan page displays.
	

	3
	Maintain Maintenance Plan Parameters
	Make the following entries:
1. Maintenance Plan For: Maintenance Order PM
· Maintenance Plan Type: Single Cycle (Time Based)
· Choose Continue.
	The Create Maintenance Plan: Plan %xxxxxxxxxxx page displays.
The default view is Items.
	

	4
	Maintain Maintenance Plan Item Data
	In the Items part, make the following entries for the first item:
1. Item Description: Mechanical Inspection for Pump
· Technical Object: 21010XXXX
· Order Type: YBA2
· Plant: 1010
· Work Center: <Work Center>
The work center is filled according to the technical object.
· Plant of Work Center: 1010
· Planner Group: <Planner Group>
The planner group is filled according to the technical object.
In the lower screen, choose General Data tab. Make the following entries:
· Maintenance Activity Type: YB4
In the General Data tab, Task List section, choose Assign Task List.
On the Assign Task List screen, make the following entries and choose OK.
1. Task List Type: General Maintenance Task List
· Task List Group: <Task List Group>
Comment: Please fill in the task list group number which is created in the previous step. Or use the Search to choose.
· Group Counter:
Comment: Please fill in the group counter created in the previous step.
· Choose OK.
A valid task list is now assigned to the maintenance plan.
· Choose Planning Data tab.
· Choose Enter.
	The Maintenance Plan Planning Data view displays.
	

	5
	Maintain Maintenance Plan Planning Data
	In the Planning Data part, Date Determination section, make the following entries:
1. Start Date for Scheduling: <Current date>
Comment: The start date is needed for mass schedule maintenance plans.
· Shift Factor for Early Completion: 100
· Shift Factor for Late Completion: 100
Comment: The shift factor in the event of early/late completion of a maintenance task defines the percentage of the shift to be applied to the calculation of the next date.
1. Tolerance (+): 10
· Tolerance (-): 10
Comment: The tolerance, in the case of early/late completion, determines the time span in which variances between actual and planned dates do not influence subsequent scheduling. The tolerance is defined as a percentage rate of the smallest interval between the maintenance cycles of the maintenance strategy.
· Cycle Modification Factor: 1
· Lead Float:
In the Call Control section, make the following entries:
1. Scheduling Period: 365
Comment: You can use the scheduling period to determine the length of time for which the system creates maintenance calls during maintenance plan scheduling.
· Call Horizon: 50
Comment: The call horizon determines when a maintenance call object, for example, a maintenance order should be generated for a maintenance call.
· Completion Required: X
Comment: If you set this indicator, the system only generates the next call object once the preceding call object has been confirmed.
In the Cycle section, make the following entries:
· Cycle / Unit: 1 MON
Comment: Cycle /unit defines the duration in which the maintenance is to be executed.
· Cycle Description: Monthly
· Offset/Unit:
· Choose Enter.
	The maintenance plan is created.
	

	6
	Save Maintenance Plan
	Choose Save.
	The Maintenance Plan is created.
	


[bookmark: unique_12][bookmark: _Toc51256755]Schedule Maintenance Plan
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
When you schedule your maintenance plan for the first time, you trigger the maintenance cycle. The system uses the scheduling information in the maintenance plan to calculate the due date of maintenance call object.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad is displayed.
	

	2
	Open Schedule Maintenance Plan
	Open Schedule Maintenance Plan (IP10).
	The Schedule Maintenance Plan: Initial page displays.
	

	3
	Search Maintenance Plan
	Make the following entries and choose Enter.
1. MaintenancePlan: <Maintenance Plan number>
Please use the single cycle plan (time based) created in the previous step.
	The Schedule Maintenance Plan: Single Cycle Plan <Maintenance Plan number> page displays.
	

	4
	Schedule Maintenance Plan
	Choose Start.
On the Start Date screen, enter a start date. For example, enter current date.
Start of cycle: <Current Date>
Choose Continue.
You receive an overview of scheduled calls with plan date and call date of a schedule call based on the start date you entered and based on the scheduling parameters that are maintained in the maintenance plan.
Comment: The scheduling list shows scheduled calls with assigned call dates. Each call has its own system status with scheduling type. The first call has the Type New Start with status Hold.
When you want to create a planned order for the first time before reaching the call date, you can use the function release call.
Flag the first row in Scheduling List.
Choose Release Call.
Choose Save and confirm all the messages that appear.
To check the automatically created preventive maintenance order, follow these steps:
1. Open Schedule Maintenance Plan again.
· Enter the maintenance plan number.
· Choose Enter.
· In the Scheduling List, choose the first line you have called.
· Choose Display Call Object.
· Note the maintenance order number.
	The first checking step of the maintenance plan has been scheduled.
The preventive maintenance order is created automatically.
The notification of activity report is created automatically.
The material reservation is created automatically if stock material is needed.
	


Result
The maintenance plan has been scheduled.
Hint: In case you want to use mass scheduling instead of manually scheduling maintenance plan, you can use tile Mass Schedule Maintenance Plans with business role Maintenance Planner.
To start mass scheduling, you must have entered a start date in the maintenance plan or have scheduled the maintenance plan once.
[bookmark: d2e1480][bookmark: _Toc51256756]Time-Based Strategy Plan
[bookmark: unique_13][bookmark: _Toc51256757]Maintain Maintenance Strategies
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
A maintenance strategy represents a rule for the sequence of planned maintenance and inspection tasks.
A time based maintenance strategy contains the maintenance packages that define the cycle in which the tasks must be performed, for example, every 10 days, every 3 months, and so on. It contains additional scheduling parameters such as shift factor, preliminary and follow-up buffers, and hierarchy. Maintenance strategies are required in strategy plans.
For each plant, you may use the same maintenance strategy. You can skip this step if the maintenance strategy exists.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad is displayed.
	

	2
	Open Maintenance Strategy
	Open Maintenance Strategies (IP12).
	The Display Maintenance Strategies: Overview screen displays.
	

	3
	Switch to Change mode
	Choose More > Table View > Display > Change or click Edit button on right top.
	The Change Maintenance Strategies: Overview page displays.
	

	4
	Create Maintenance Strategy
	Choose New Entries. Make the following entries.
1. Name:EAM_<XX>
· Description: <Description> for example: Mechanical Inspection
· Scheduling Indicator: Time
· Strategy unit: MON
Choose Save.
	The new maintenance strategy is created.
	

	5
	Add Maintenance Packages
	On the left side of the screen, in the Dialog Structure, double-click on the Packages folder.
Choose New Entries.
Make the following entries:
1. Package No.: 1
· Cycl. Length: 1
· Unit: MON
· Maintenance cycle text: Monthly
· Cycle short text: 1M
· Hierarchy: 1
· Hierarchy short text: 1H
Repeat the above step for further cycles. Create the following packages.
1. Package No.: 2
· Cycl. Length: 3
· Unit: MON
· Maintenance cycle text: Quarterly
· Cycle short text: 3M
· Hierarchy: 1
· Hierarchy short text: 1H
· Package No.: 3
· Cycl. Length: 6
· Unit: MON
· Maintenance cycle text: Half-yearly
· Cycle short text: 6M
· Hierarchy: 1
· Hierarchy short text: 1H
· Package No.: 4
· Cycl. Length: 12
· Unit: MON
· Maintenance cycle text: Yearly
· Cycle short text: 1Y
· Hierarchy: 1
· Hierarchy short text: 1H
Choose Save.
	The Change Maintenance Packages page displays.
The Maintenance Packages are maintained in Maintenance Strategy.
	


[bookmark: unique_14][bookmark: _Toc51256758]Create General Task List
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
Using task lists, you can centrally define and manage maintenance tasks for your technical objects. General task lists can also help you to prepare maintenance plans and orders.
A task list group combines one or more task lists according to their logical features. Within a task list group, each task list is identified by a group counter. This enables you, for example, to combine several task lists in one group. Within the group, the system allocates a sequential number (the group counter) to each individual task list.
Prerequisite
Technical objects in the form of functional locations, equipment, and maintenance assemblies.
Organizational units such as maintenance planners and work centers.
Costs centers defined in the master data of the technical objects.
Maintenance spare parts and assemblies in the MM (Materials Management) module.
Maintenance strategy.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad displays.
	

	2
	Open Create Task List
	Open .
	The Create Task List page appears.
	

	3
	Choose Task List Type
	Choose Task List Type: General Maintenance Task List.
	The Create General Maintenance Task List screen displays.
	

	4
	Enter Creation Parameters
	Make the following entries:
1. Task List Group:
Comment: Task list group uses internal number range.
· Planning Plant: 1010
· Group Counter:
Comment: The group counter would increase automatically if you create another task list for the same technical object.
· Status: Released (general)
· Select the relevant profile for the plant.
· Key Date: <Today>
· Choose Continue.
	The Create General Maintenance Task List page displays.
	

	5
	Maintain General Data
	Enter the following entries:
1. Description: <Description>
Make your own description. For example, Mechanical Inspection
· Status:Released (General)
· Planner Group: YB1
· Work Center: RES-0100
· Work Center Plant: 1010
· Assembly:
· Maintenance Strategy: EAM_<XX>
Comment: Please use the maintenance strategy created in the previous step.
1. System Condition: not in operation
· Choose Operation Data.
	The Operation Data tab appears.
	

	6
	Maintain Operation Data
	Enter the following entries and choose Enter.
1. Operation: 0010
· Description: Check the pump
· Work: 2
· Unit: H
· Capacities: 2
· Operation: 0020
· Description: Check the Bearings
· Work: 1
· Unit: H
· Capacities: 1
· Operation : 0030
· Description: Check the coupling
· Work: 2
· Unit: H
· Capacities: 2
· Operation: 0040
· Description: Check the shaft
· Work: 3
· Unit: H
· Capacities: 3
Choose the operation 0010.
In the lower part of the screen, Details: Operation 0010, Check the pump section, choose Materials.
Make the following entries and choose Enter.
1. Material: SP005
· Quantity : 1
Repeat the above step for other operations
1. Operation Item: 0020
· Material: SP001
· Quantity: 2
· Operation Item: 0030
· Material: SP002
· Quantity: 1
· Operation Item: 0040
· Material: SP003
· Quantity: 2
Choose Maintenance Packages.
	The Maintenance Packages tab appears.
	

	7
	Maintain Maintenance Packages
	Make the following entries and choose Save.
1. For operation 0010, set flag for Monthly
· For operation 0020, set flag for Quarterly
· For operation 0030, set flag for Half-yearly
· For operation 0040, set flag for Yearly
	The general task list is created.
	


[bookmark: unique_15][bookmark: _Toc51256759]Create Maintenance Plan
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
Maintenance plan will have maintenance or inspection activities to be carried out for technical objects.
The frequency or strategy and, scope of the activities are defined in the maintenance plan.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the Fiori Launchpad as Maintenance Planner.
	The SAP Fiori launchpad is displayed.
	

	2
	Open Create Maintenance Plan
	Open Create Maintenance Plan .
	The Create Maintenance Plan page displays.
	

	3
	Maintain Maintenance Plan Parameters
	Make the following entries:
1. Maintenance Plan For: Maintenance Order PM
· Maintenance Plan Type: Strategy
· Maintenance Strategy: EAM_<XX>
Comment: You can use the maintenance strategy created in the previous step.
· Choose Continue
	The Create Maintenance Plan: Strategy Plan %xxxxxxxxxxx page displays.
The default view is Items.
	

	4
	Maintain Maintenance Plan Item Data
	In the Items part, make the following entries for the first item:
1. Item Description: Mechanical Inspection for Pump
· Technical Object: 21010XXXX
· Order Type: YBA2
· Plant: 1010
· Work Center: <Work Center>
The work center is filled according to the technical object.
· Plant of Work Center: 1010
· Planner Group: <Planner Group>
The planner group is filled according to the technical object.
In the lower screen, choose General Data tab.
Make the following entries and choose Enter:
· Maintenance Activity Type: YB4
Still in the General Data tab, Task List section, choose Assign Task List.
On the Assign Task List screen, make the following entries:
1. Task List Type: General Maintenance Task List
· Task List Group: <Task List Group>
Comment: Please fill in the task list group number which is created in the previous step. Or use the Search help to choose.
· Group Counter:
Comment: Please fill in the Group Counter created in the previous step.
Choose OK.
A valid task list is now assigned to the maintenance plan.
Choose Planning Data tab.
	The maintenance plan Planning Data view displays.
	

	5
	Maintain Maintenance Plan Planning Data
	In the Planning Data part, Date Determination section, make the following entries and choose Enter.
1. Start Date for Scheduling: <Current date>
Comment: The start date is needed for mass schedule maintenance plans.
· Shift Factor for Early Completion: 100
· Shift Factor for Late Completion: 100
Comment: The shift factor in the event of early/late completion of a maintenance task defines the percentage of the shift to be applied to the calculation of the next date.
· Tolerance (+): 10
· Tolerance (-): 10
Comment: The tolerance, in the case of early/late completion determines the time span in which variances between actual and planned dates do not influence subsequent scheduling.
The tolerance is defined as a percentage rate of the smallest interval between the maintenance cycles of the maintenance strategy.
· Cycle Modification Factor: 1
· Lead Float:
· In the Call Control section, make the following entries:
· Scheduling Period: 365
Comment: You can use the scheduling period to determine the length of time for which the system creates maintenance calls during maintenance plan scheduling.
· Call Horizon: 50
Comment: The call horizon determines when a maintenance call object, for example, a maintenance order should be generated for a maintenance call.
· Completion Required: X
Comment: If you set this indicator, the system only generates the next call object once the preceding call object has been confirmed.
	The maintenance plan is created.
	

	6
	Save Maintenance Plan
	Choose Save.
	The maintenance plan is created.
	


[bookmark: unique_16][bookmark: _Toc51256760]Schedule Maintenance Plan
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
When you schedule your maintenance plan for the first time, you trigger the maintenance cycle. The system uses the scheduling information in the maintenance plan to calculate the maintenance package that is due next.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad is displayed.
	

	2
	Open Schedule Maintenance Plan
	Open Schedule Maintenance Plan (IP10).
	The Schedule Maintenance Plan: Initial page displays.
	

	3
	Search Maintenance Plan
	Make the following item entries and choose Enter.
1. MaintenancePlan: <Maintenance Plan number>
Please use the maintenance plan created in the previous step.
	The Schedule Maintenance Plan: Strategy Plan <Maintenance Plan number> page displays.
	

	4
	Schedule Maintenance Plan
	Choose Start.
On the Start Date screen, enter a start date. For example, enter current day's date.
Start of cycle: <Current Date>
Choose Continue.
You receive an overview of scheduled calls with plan date and call date of a schedule call based on the start date you entered and the scheduling parameters that are maintained in the maintenance plan.
Comment: The scheduling list shows scheduled calls with assigned call dates. Each call has its own system status with the scheduling type.
The first call has the scheduling type New Start with status Hold. When you want to create a planned order for the first time before reaching the call date you can use the function Release Call.
Flag the first row in Scheduling List.
Choose Release Call.
Choose Save and confirm all the messages that appear.
To check the automatically created preventive maintenance order:
1. Open Schedule Maintenance Plan again.
· Enter the maintenance plan number.
· Choose Enter.
· In the Scheduling List, choose the first line you have called.
· Choose Display Call Object.
· Note the maintenance order number.
	The first checking step of maintenance plan has been scheduled.
The preventive maintenance order is created automatically.
The notification of activity report is created automatically.
The material reservation is created automatically if stock material is needed.
	


Result
The maintenance plan has been scheduled.
Hint: In case you want to use mass scheduling instead of manually scheduling a maintenance plan, you can use the tile Mass Schedule Maintenance Plans (IP30H) with business role Maintenance Planner.
To start mass scheduling, you must have entered a start date in the maintenance plan or scheduled the maintenance plan once.
[bookmark: d2e1873][bookmark: _Toc51256761]Performance-Based Single Cycle Plan
[bookmark: unique_17][bookmark: _Toc51256762]Create General Task List
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
Using task lists, you can centrally define and manage maintenance tasks for your technical objects. General task lists can also help you prepare maintenance plans and orders.
A task list group combines one or more task lists according to their logical features. Within a task list group, each task list is identified by a group counter. This enables you, for example, to combine several task lists in one group. Within the group, the system allocates a sequential number (the group counter) to each individual task list.
Prerequisite
Technical objects in the form of functional locations, equipment, and maintenance assemblies.
Organizational units such as maintenance planners and work centers.
Costs centers defined in the master data of the technical objects.
Maintenance spare parts and assemblies in the Materials Management (MM) module.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as Maintenance Planner .
	The SAP Fiori launchpad displays.
	

	2
	Open Create Task List
	Open Create Task List .
	The Create Task List screen displays.
	

	3
	Choose Your Task List Type
	Choose Task List Type : General Maintenance Task List
	The Create General Maintenance Task List screen appears.
	

	4
	Enter Creation Parameters
	Make the following entries:
1. Task List Group:
Comment: The task list group uses internal number range.
· Planning Plant: 1010
· Group Counter:
Comment: The group counter would increase automatically if you create another task list for the same technical object.
· Status: Released (general)
· Select the relevant profile for the plant.
· Key Date: <Today>
· Choose Continue.
	The Create General Maintenance Task List screen displays.
	

	5
	Maintain General Data
	Make the following entries:
1. Description: Description
Make your own description. For example, Mechanical Inspection
· Status: Released (General)
· Planner Group: YB1
· Work Center: RES-0100
· Work Center Plant: 1010
· Assembly:
· System Condition: not in operation
· Choose Operation Data.
	The Operation Data tab displays.
	

	6
	Maintain Operation Data
	Enter the following entries and choose Enter.
1. Operation: 0010
· Description: Check the pump
· Work: 2
· Unit: H
· Capacities: 2
· Operation: 0020
· Description: Check the bearings
· Work: 1
· Unit: H
· Capacities: 1
· Operation : 0030
· Description: Check the coupling
· Work: 2
· Unit: H
· Capacities: 2
· Operation: 0040
· Description: Check the shaft
· Work: 3
· Unit: H
· Capacities: 3
· Choose the Operation 0010.
In the lower part of the screen, Details: Operation 0010, check the pump section, choose Materials.
Make the following entries and choose Enter.
1. Material: SP005
· Quantity: 1
· Repeat the above step for other operations
· Operation Item: 0020
· Material: SP001
· Quantity: 2
· Operation Item: 0030
· Material: SP002
· Quantity: 1
· Operation Item: 0040
· Material: SP003
· Quantity: 2
Choose Save
	The general task list is created.
	


[bookmark: unique_18][bookmark: _Toc51256763]Create Maintenance Plan
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
Maintenance plan will have maintenance or inspection activities to be carried out for technical objects.
The frequency or strategy and, scope of the activities are defined in the maintenance plan.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad displays.
	

	2
	Open Create Maintenance Plan
	Open Create Maintenance Plan
	The Create Maintenance Plan screen displays.
	

	3
	Maintain Maintenance Plan Parameters
	Make the following entries, choose Continue:
1. Maintenance Plan For: Maintenance Order PM
· Maintenance Plan Type: Single Cycle (Performance Based)
	The Create Maintenance Plan: Plan %xxxxxxxxxxx screen displays.
The default view is Items.
	

	4
	Maintain Maintenance Plan Item Data
	In the items part, make the following entries for the first item:
1. Item Description: Mechanical Inspection for Pump
· Technical Object: 21010XXXX
· Order Type: YBA2
· Plant: 1010
· Work Center: <Work Center>
The work center is filled according to the technical object.
· Plant of Work Center: 1010
· Planner Group:<Planner Group>
The planner group is filled according to the technical object.
· In the lower part of the screen, choose General Data tab. Make the following entries and choose Enter.
· Maintenance Activity Type: YB4
· In the General Data tab, Task List section, choose Assign Task List.
· On the Assign Task List screen, make the following entries and choose OK.
· Task List Type: General Maintenance Task List
· Task List Group: <Task List Group>
Comment: Fill in the task list group number which is created in the previous step. Or use the Search help to choose.
· Group Counter:
Comment: Fill in the group counter created in the previous step.
· Choose OK.
A valid task list is now assigned to the maintenance plan.
· Choose Planning Data tab.
	The Maintenance Plan Planning Data screen displays.
	

	
	Maintain Maintenance Plan Planning Data
	In the Planning Data part,
Date Determination section, make the following entries and choose Enter.
1. Start Counter reading < Counter reading >
Comment: Counter reading can be entered here which can be used at the time of scheduling the plan
· Shift Factor for Early Completion: 100
· Shift Factor for Late Completion: 100
Comment: The shift factor in the event of early / late completion of a maintenance task defines the percentage of the shift to be applied to the calculation of the next date.
· Tolerance (+): 10
· Tolerance (-): 10
Comment: The tolerance, in the case of early / late completion, determines the time span in which variances between actual and planned date do not influence subsequent scheduling. The tolerance is defined as a percentage rate of the smallest interval between the mainte-nance cycles of the maintenance strategy.
· Cycle Modification Factor: 1
· Lead Float:
In the Call Control section, make the following entries:
1. Scheduling Period: 365 DAY
Comment: You can use the scheduling period to determine the length of time for which the system creates maintenance calls during maintenance plan scheduling.
· Call Horizon: 50
Comment: The call horizon determines when a maintenance call object, for example, a maintenance order should be generated for a maintenance call.
· Completion Required: X
Comment: If you set this indicator, the system only generates the next call object once the preceding call object has been confirmed.
· In the Cycle section, make the following entries:
· Cycle / Unit: 100 H
Comment: Cycle /Unit defines the duration on which the maintenance is to be executed.
· Cycle Description: Every 100 Hours
· Offset/Unit:
· Counter:< Measuring Point No >
Comment: Enter the measuring point number created for the technical object type. Based on readings entered according to the mentioned measuring point, maintenance call will be trigerred once the plan is scheduled.
	The maintenance plan is created.
	

	
	Save Maintenance Plan
	Choose Save
	The maintenance plan is created.
	


[bookmark: unique_19][bookmark: _Toc51256764]Create Measurement Document
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
The Maintenance Planner needs to record initial reading of the technical objects (equipment / functional location) in the SAP system. Atleast one measurement document is required for scheduling the plan. Once the scheduling is done, regular readings must also be recorded in the system by the Maintenance Technician. This process can also be automated my making use of systems which get the reading from technical objects and load to SAP system through interfaces.
Time-to-time recording of these readings are relevant for accurate determination of maintenance due dates.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad displays.
	

	2
	Create Measurement Document
	Open Create Measurement Document for Technical Object (EAMS_WDA_MD_OIF).
On the Create Measurement Documents screen, make the following entries:
1. Basis for measurement reading:Measuring Point
Measuring Point: <Measuring Point No>
Comment: Enter the measuring point number created against the technical object.
· Choose Continue.
	The Create Measurement Documents screen displays.
	

	3
	Enter Counter
	A new screen appears with the measuring point that was entered.
1. Enter Reading: <Counter reading>
· Choose Save.
	The measurement document is created.
	


Result
The measurement documents are created and they help to determine the accurate maintenance due dates.
[bookmark: unique_39][bookmark: _Toc51256765]Schedule Maintenance Plan
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
When you schedule your maintenance plan for the first time, you trigger the maintenance cycle. The system uses the scheduling information in the maintenance plan to calcu-late the due date of the maintenance call object.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad displays.
	

	2
	Open Schedule Maintenance Plan
	Open Schedule Maintenance Plan (IP10).
	The Schedule Maintenance Plan: Initial screen displays.
	

	3
	Search Maintenance Plan
	Make the following item entries and choose Enter.
1. Maintenance Plan: <Maintenance Plan number>
Please use the single cycle plan (perfomance-based) created in the previous step.
	The Schedule Maintenance Plan: Single Cycle Plan <Maintenance Plan number> screen displays.
	

	4
	Schedule Maintenance Plan
	Follow these steps:
1. Choose Start.
1. On the Start Date screen, enter a start date. For example, enter current date.
2. Start of cycle:<Counter reading >
Note If a start counter reading was entered during the maintenance plan creation, the system will propose that reading as the start counter reading. It can be changed to a different reading as well, if required.
3. Choose Continue.
You will receive an overview of scheduled calls with plan date and call date of a scheduled call.
The overview is based on your start of cycle counter reading, annual estimate (entered against respective measuring point), and scheduling parameters that are maintained in the maintenance plan.
Comment: The scheduling list shows scheduled calls with assigned call dates. Each call has its own system status with scheduling type. The first call has the type New Start with status Hold.
4. When you want to create a planned order for the first time before reaching the call date, you can use the function Release Call.
Flag the first row in the scheduling list.
Choose Release Call.
5. Choose Save and confirm all the messages that appear.
To check the automatically created preventive maintenance order:
1. Open the schedule maintenance plan again.
2. Enter the maintenance plan number.
3. Choose Enter.
4. In the Scheduling List, choose the first line you have called.
5. Choose Display Call Object.
6. Note the maintenance order number.
	The first checking step of maintenance plan has been scheduled.
The preventive maintenance order is created automatically.
The notification of activity report is created automatically.
The material reservation is created automatically if stock material is needed.
	


Result
The maintenance plan has been scheduled.
Hint: If you want to use Mass Scheduling instead of manually scheduling maintenance plans, you can use tile Mass Schedule Maintenance Plans (IP30H) with business role Maintenance Planner.
To start mass scheduling, you must have entered a start counter reading in the maintenance plan or scheduled the maintenance plan once.
[bookmark: d2e2266][bookmark: _Toc51256766]Performance-Based Strategy Plan
[bookmark: unique_21][bookmark: _Toc51256767]Maintain Maintenance Strategies
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
A maintenance strategy represents a rule for the sequence of planned maintenance and inspection tasks. A maintenance strategy for performance plan contains the maintenance packages that define the cycle in which the tasks must be performed. For example, every 5000 km, every 500 operating hours, and so on. It contains additional scheduling parameters such as shift factor, preliminary and follow-up buffers, and hierarchy. Maintenance strategies are required in strategy plans.
For each plant, you may use the same maintenance strategy. You can skip this step if the maintenance strategy exists.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad displays.
	

	2
	Open Maintenance Strategy
	Open Maintenance Strategies (IP12).
	The Display Maintenance Strategies: Overview screen displays.
	

	3
	Switch to Change mode
	Choose More > Table View > Display > Change or click on Edit button on top right.
	The Change Maintenance Strategies: Overview page displays.
	

	4
	Create Maintenance Strategy
	Choose New Entries. Make the following entries.
1. Name: EAM_<XX>
· Description: <Description> for example: Mechanical Inspection
· Scheduling Indicator: Activity
· Strategy unit: H
Choose Save.
	The new maintenance strategy is created.
	

	5
	Add Maintenance Packages
	On the left side of the screen, in Dialog Structure,　double-click on the Packages folder.
Choose New Entries.
Make the following entries:
1. Package No.: 1
· Cycl. Length: 100
· Unit: H
· Maintenance cycle text: 100 OPH
· Cycle short text: 1H
· Hierarchy: 1
· Hierarchy short text: 1H
Repeat the above step for further cycles. Create the following packages.
1. Package No.: 2
· Cycl. Length: 250
· Unit: H
· Maintenance cycle text: 250 OPH
· Cycle short text: 2H
· Hierarchy: 1
· Hierarchy short text: 1H
· Package No.: 3
· Cycl. Length: 500
· Unit: H
· Maintenance cycle text: 500 OPH
· Cycle short text: 3H
· Hierarchy: 1
· Hierarchy short text: 1H
· Package No.: 4
· Cycl. Length: 1000 OPH
· Unit: H
· Maintenance cycle text: 1000 OPH
· Cycle short text: 4H
· Hierarchy: 1
· Hierarchy short text: 1H
Choose Save.
	The Change Maintenance Packages page displays.
The maintenance packages are maintained in Maintenance Strategy.
	


[bookmark: unique_22][bookmark: _Toc51256768]Create General Task List
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
Using task lists, you can centrally define and manage maintenance tasks for your technical objects. General task lists can also help you to prepare maintenance plans and orders.
A task list group combines one or more task lists according to their logical features. Within a task list group, each task list is identified by a group counter. This enables you, for example, to combine several task lists in one group. Within the group, the system allocates a sequential number (the group counter) to each individual task list.
Prerequisite
Technical objects in the form of functional locations, equipment, and maintenance assemblies.
Organizational units such as maintenance planners and work centers.
Costs centers defined in the master data of the technical objects.
Maintenance spare parts and assemblies in the Materials Management (MM) module.
Maintenance strategy.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad displays.
	

	2
	Open Create Task List
	Open Create Task List .
	The Create Task List screen appears
	

	3
	Choose Task List Type
	Choose Task List Type: General Maintenance Task List.
	The Create General Maintenance Task List screen displays.
	

	4
	Enter Creation Parameters
	Make the following entries.
1. Task List Group:
Comment: Task List Group uses internal number range.
· Planning Plant: 1010
· Group Counter:
Comment: The group counter would increase automatically if you create another task list for the same technical object.
· Status: Released (general)
· Select the relevant profile for the plant.
· Key Date:<Today>
Choose Continue.
	The Create General Maintenance Task List screen displays.
	

	5
	Maintain General Data
	Make the following entries:
1. Description:<Description>
Make your own description. For example: Mechanical Inspection
· Status: Released (General)
· Planner Group: YB1
· Work Center: RES-0100
· Work Center Plant: 1010
· Assembly:
· Maintenance Strategy: EAM_<XX>
Comment: You can use the maintenance strategy created in the previous step.
· System Condition: not in operation
· Choose Operation Data
.
	The Operation Data tab appears.
	

	6
	Maintain Operation Data
	Make the following entries and choose Enter.
1. Operation: 0010
· Description: Check the pump
· Work: 2
· Unit: H
· Capacities: 2
· Operation: 0020
· Description: Check the bearings
· Work: 1
· Unit: H
· Capacities: 1
· Operation : 0030
· Description: Check the coupling
· Work: 2
· Unit: H
· Capacities: 2
· Operation: 0040
· Description: Check the shaft
· Work: 3
· Unit: H
· Capacities: 3
Choose the Operation 0010.
In the lower part of the screen, Details: Operation 0010, check the pump section. Choose Materials.
Make the following entries and choose Enter.
1. Material: SP005
· Quantity: 1
Repeat the above step for other operations.
1. Operation Item: 0020
· Material: SP001
· Quantity: 2
· Operation Item: 0030
· Material: SP002
· Quantity: 1
· Operation Item: 0040
· Material: SP003
· Quantity: 2
Choose Maintenance Packages.
	The Maintenance Packages tab appears.
	

	7
	Maintain Mainte-nance Packages
	Enter the following entries and choose Save.
1. For Operation 0010, set Flag for 100 OPH
· For Operation 0020, set Flag for 250 OPH
· For Operation 0030, set Flag for 500 OPH
· For Operation 0040, set Flag for 1000 OPH
	The general task list is created.
	


[bookmark: unique_23][bookmark: _Toc51256769]Create Maintenance Plan
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
Maintenance plan will have maintenance or inspection activities to be carried out for technical objects.
The frequency or strategy and, scope of the activities are defined in the maintenance plan.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad displays.
	

	2
	Open Create Maintenance Plan
	Open Create Maintenance Plan .
	The Create Maintenance Plan screen displays.
	

	3
	Maintain Maintenance Plan Parameters
	Make the following entries, and choose Continue:
1. Maintenance Plan For: Maintenance Order PM
· Maintenance Plan Type: Strategy
· Maintenance Strategy: EAM_<XX>
Comment: You can use the maintenance strategy created in the previous step.
	The Create Maintenance Plan: Strategy Plan %xxxxxxxxxxx screen displays.
The default view is Items.
	

	4
	Maintain Maintenance Plan Item Data
	In the Items part, make the following entries for the first item:
1. Item Description: Mechanical Inspection for Pump
· Technical Object: 21010XXXX
· Order Type: YBA2
· Plant: 1010
· Work Center: <Work Center>
The work center is filled according to the technical object.
· Plant of Work Center: 1010
· Planner Group: <Planner Group>
The planner group is filled according to the technical object.
In the lower screen, choose General Data tab. Make the following entries and choose Enter.
1. Maintenance Activity Type: YB4
In the General Data tab, Task List section, choose Assign Task List.
On the Assign Task List screen, make the following entries and choose OK.
· Task List Type: General Maintenance Task List
· Task List Group: <Task List Group>
Comment: You can fill in the task list group number which was created in the previous step. Or use the Search help to choose.
· Group Counter:
Comment: You can fill in the group counter that was created in the previous step.
A valid task list is now assigned to the maintenance plan.
· Choose Planning Data tab.
	The Maintenance Plan Planning Data screen displays.
	

	5
	Maintain Maintenance Plan Planning Data
	In the Planning Data part, Date Determination section, make the following entries and choose Enter.
1. Counter: <Measuring Point No>
Comment: Enter the measuring point number created for the technical object type. Based on readings entered according to the mentioned measuring point, the maintenance call will be trigerred once the plan is scheduled.
· Shift Factor for Early Completion : 100
· Shift Factor for Late Completion: 100
Comment: The shift factor in the event of early/late completion of a maintenance task defines the percentage of the shift to be applied to the calculation of the next date.
· Tolerance (+): 10
Tolerance (-): 10
Comment: The tolerance in the case of early / late completion, determines the time span in which variances between actual and planned date do not influence subsequent scheduling. The tolerance is defined as a percentage rate of the smallest interval between the maintenance cycles of the maintenance strategy.
· Cycle Modification Factor: 1
· Lead Float:
In the Call Control section, make the following entries:
1. Scheduling Period: 365
Comment: You can use the scheduling period to determine the length of time for which the system creates maintenance calls during maintenance plan scheduling.
· Call Horizon: 50
Comment: The call horizon determines when a maintenance call object, for example, a maintenance order should be generated for a maintenance call.
· Completion Required: X
Comment: If you set this indicator, the system only generates the next call object once the preceding call object has been confirmed.
	The maintenance plan is created.
	

	6
	Save Maintenance Plan
	Choose Save.
	The maintenance plan is created.
	


[bookmark: unique_24][bookmark: _Toc51256770]Create Measurement Document
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
Maintenance Planner needs to record initial reading of the technical objects (equipment / functional location) in the SAP system. Atleast one measurement document is required for scheduling the plan. Once scheduling is done, regular readings must also be recorded in the system by the Maintenance Tehnician. This process also can be automated my making use of the systems which gets the reading from technical objects and loads to SAP system through interfaces.
Time-to-time recording of these readings are relevant for accurate determination of maintenance due dates.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad displays.
	

	2
	Create Measurement Document
	Open Create Measurement Document for Technical Object (EAMS_WDA_MD_OIF)
On the Create Measurement Documents screen, make the following entries:
1. Basis for measurement reading: Measuring Point
· Measuring Point: < Measuring Point No>
Comment: Enter the measuring point number that was created against the technical object.
· Choose Continue.
	The Create Measurement Documents screen displays.
	

	3
	Enter Counter Reading
	A new screen appears with the measuring points you entered:
1. Reading: <Counter reading >
· Choose Save
	Measurement document is created.
	


Result
The measurement documents are created and these will serve to determine the accurate maintenance due dates.
[bookmark: unique_25][bookmark: _Toc51256771]Schedule Maintenance Plan
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
When you schedule your maintenance plan for the first time, you trigger the maintenance cycle. The system uses the scheduling information in the maintenance plan to calculate the maintenance package that is due next.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad displays.
	

	2
	Open Schedule Maintenance Plan
	Open Schedule Maintenance Plan (IP10).
	The Schedule Maintenance Plan: Initial screen displays.
	

	3
	Search Maintenance Plan
	Make the following item entries and choose Enter.
1. Maintenance Plan: <Maintenance Plan number>
You can use the maintenance strategy created in the previous step.
	The Schedule Maintenance Plan: Strategy Plan <Maintenance Plan number> screen displays.
	

	4
	Schedule Maintenance Plan
	Follow these steps:
1. Choose Start.
· Start of cycle: <Current counter reading>
· Choose Continue.
You receive an overview of scheduled calls with plan date and call date of a schedule call based on the start date you entered and on the scheduling parameters maintained in the maintenance plan.
Comment: The scheduling list shows scheduled calls with assigned call dates. Each call has its own system status with the scheduling type.
The first call has the Type New Start with Status Hold. When you want to create a planned order for the first time before reaching the call date you can use the function Release Call.
· Flag the first row in Scheduling List.
· Choose Release Call.
· Choose Save and confirm all the messages that appear.
To automatically check the created preventive maintenance order, follow these steps:
1. Open Schedule Maintenance Plan again
.
· Enter the maintenance plan number.
· Choose Enter
· In the Scheduling List, choose the first line you have called.
· Choose Display Call Object.
· Note the maintenance order number.
	The first checking step of maintenance plan has been scheduled.
The preventive maintenance order is created automatically.
The notification of activity report is created automatically.
The material reservation is created automatically if stock material is needed.
	


Result
The maintenance plan has been scheduled.
Hint: In case you want to use mass scheduling instead of manually scheduling maintenance plans, you can use the tile Mass Schedule Maintenance Plans (IP30H) with business role Maintenance Technician.
To start mass scheduling, you must have entered a start date in the maintenance plan or have scheduled the maintenance plan once.
[bookmark: d2e2757][bookmark: _Toc51256772]Multiple Counter Plan
[bookmark: unique_26][bookmark: _Toc51256773]Create General Task List
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
Using task lists, you can centrally define and manage maintenance tasks for your technical objects. General task lists can also help you to prepare maintenance plans and orders.
A task list group combines one or more task lists according to their logical features. Within a task list group, each task list is identified by a group counter. This enables you, for example, to combine several task lists in one group. Within the group, the system allocates a sequential number (the group counter) to each individual task list.
Prerequisite
Technical objects in the form of functional locations, equipment, and maintenance assemblies.
Organizational units such as maintenance planners and work centers.
Costs centers defined in the master data of the technical objects.
Maintenance spare parts and assemblies in the MM (Materials Management) module.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad displays.
	

	2
	Open Create Task List
	Open Create Task List .
	The Create Task List screen appears.
	

	3
	Choose Task List Type
	Choose Task List Type: General Maintenance Task List.
	The Create General Maintenance Task List screen displays.
	

	4
	Enter Creation Parameters
	Make the following entries:
1. Task List Group:
Comment: The task list group uses internal number range.
· Planning Plant: 1010
· Group Counter:
Comment: The group counter would increase automatically if you create another task list for the same technical object.
· Status: Released (general)
· Select the relevant profile for the plant.
· Key Date: <Today>
· Choose Continue.
	The Create General Maintenance Task List screen displays.
	

	
	Maintain General Data
	Make the following entries:.
1. Description:<Description>
Make your own description. For example: Mechanical Inspection
· Status: Released (General)
· Planner Group: YB1
· Work Center: RES-0100
· Work Center Plant: 1010
· Assembly:
· System Condition: not in operation
· Choose Operation Data.
	The Operation Data tab appears.
	

	
	Maintain Operation Data
	Make the following entries and choose Enter.
1. Operation: 0010
· Description: Check the pump
· Work: 2
· Unit: H
· Capacities: 2
· Operation: 0020
· Description: Check the bearings
· Work: 1
· Unit: H
· Capacities: 1
· Operation : 0030
· Description: Check the coupling
· Work: 2
· Unit: H
· Capacities: 2
· Operation: 0040
· Description: Check the shaft
· Work: 3
· Unit: H
· Capacities: 3
· Choose the Operation 0010.
· In the lower part of the screen, Details: Operation 0010, check the pump section, choose Materials.
Make the following entries and choose Enter.
1. Material: SP005
· Quantity : 1
Repeat the above step for other operations
1. Operation Item: 0020
· Material: SP001
· Quantity: 2
· Operation Item: 0030
· Material: SP002
· Quantity: 1
· Operation Item: 0040
· Material: SP003
· Quantity: 2
Choose Save
	The general task list is created.
	


[bookmark: unique_27][bookmark: _Toc51256774]Create Maintenance Plan
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
Maintenance plan will have maintenance or inspection activities to be carried out for technical objects.
The frequency or strategy and, scope of the activities are defined in the maintenance plan.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad is displayed.
	

	2
	Open Create Maintenance Plan
	Open Create Maintenance Plan
	The Create Maintenance Plan screen displays.
	

	3
	Maintain Maintenance Plan Parameters
	Make the following entries:
1. Maintenance Plan For: Maintenance Order PM
· Maintenance Plan Type: Multiple Counter
· Choose Continue.
	
The Create Maintenance Plan: Plan %xxxxxxxxxxx screen displays.
The default view is Planning Data.

	

	4
	Maintain Maintenance Plan Planning Data
	In the Planning Data part, make the following entries:
1. Description: Pump Maintenance Plan
In Date Determination section, make the following entries and choose Enter.
· Start Date: <Current Date>
Comment: The current date can be taken as the date on which scheduling the plan starts.
· Start Time:
· Cycle Modification Factor: 1
· Lead Float:
In the Call Control section, make the following entries:
· Scheduling Period: 365 DAY
Comment: You can use the scheduling period to determine the length of time for which the system creates maintenance calls during the maintenance plan scheduling.
· Completion Required: X
Comment: If you set this indicator, the system only generates the next call object once the preceding call object has been confirmed.
· Operation Type: OR Operation
Comment: If you select OR Operation, it means that an order will be created for the earliest planned date. It is the case that occurs first.
If you select AND Operation, it means that an order will be created for the last planned date. It is the case that occurs last.
In the Cycle section, make the following entries:
1. Cycle / Unit: 100 H
Comment: Cycle / unit defines the duration in which the maintenance is to be executed.
· Description of Cycle: Every 100 Hours
· Counter: <Counter No>
Comment: Enter the counter number created for the technical object type. Readings entered according to the mentioned counter number will be used to trigger the maintenance call object.
· Offset:
· Cycle / Unit: 6 MON
Comment: Cycle / unit defines the duration in which the maintenance is to be executed.
· Description of Cycle: Every 6 Months
In the Items part, make the following entries for the first item:
1. Item Description: Mechanical inspection of pump
· Technical Object: 21010XXXX
· Order Type: YBA2
· Plant: 1010
· Work Center: <Work Center>
The work center is filled according to the technical object.
· Plant of Work Center: 1010
· Planner Group: <Planner Group>
The planner group is filled according to the technical object.
In the lower part of the screen, choose General Data tab. Make the following entries and choose Enter.
· Maintenance Activity Type: YB4
· In the General Data tab, Task List section, choose Assign Task List.
On the Assign Task List screen, make the following entries and choose OK.
1. Task List Type: General Maintenance Task List
· Task List Group: <Task List Group>
Comment: Enter the task list group number which is created in the previous step. Or use the Search help to choose.
· Group Counter:
Comment: Enter the group counter created in the previous step.
A valid task list is now assigned to the maintenance plan.
	The maintenance plan is created.
	

	5
	Save Maintenance Plan
	Choose Save.
	The maintenance plan is created.
	


[bookmark: unique_28][bookmark: _Toc51256775]Create Measurement Document
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
The Maintenance Planner needs to record initial reading of the technical objects (equipment / functional location) in the SAP system. Atleast one measurement document is required for scheduling the plan.
Once the scheduling is done, regular readings must also be recorded in the system by the Maintenance Technician.
This process can also be automated my making use of systems which get the reading from technical objects and loads to SAP system through interfaces.
Time-to-time recording of these readings are relevant for accurate determination of maintenance due dates.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad is displayed.
	

	2
	Create Measurement Document
	Open Create Measurement Document for Technical Object (EAMS_WDA_MD_OIF).
On the Create Measurement Documents screen, make the following entries:
1. Basis for measurement reading: Measuring Point
· Measuring Point: <Measuring Point No>
Comment: Enter the measuring point number created against the technical object.
· Choose Continue.
	The Create Measurement Documents screen displays.
	

	3
	Enter Counter Reading
	A new screen appears with measuring point you entered.
Reading: <Counter Reading>
Choose Save.
	The measurement document is created.
	


Result
Measurement documents are created and these will help to schedule maintenance plan.
[bookmark: unique_29][bookmark: _Toc51256776]Schedule Maintenance Plan
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
When you schedule your maintenance plan for the first time, you trigger the maintenance cycle. The system uses the scheduling information in the maintenance plan to calculate the maintenance package that is due next.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad is displayed.
	

	2
	Open Schedule Maintenance Plan
	Open Schedule Maintenance Plan (IP10).
	The Schedule Maintenance Plan: Initial screen displays.
	

	3
	Search Maintenance Plan
	Make the following item entries and choose Enter:
1. Maintenance Plan: <Maintenance Plan number>
You can use the multiple counter plan created in the previous step.
	The Schedule Maintenance Plan: Single Cycle Plan <Maintenance Plan Number screen displays.
	

	4
	Schedule Maintenance Plan
	1. Choose Start.
· Choose Continue button on the information screens which appear.
· Choose Save button
You receive an overview of scheduled calls with plan date and call date of the scheduled call. This is based on your start of cycle counter reading, annual estimate (entered against respective measuring point), and the scheduling parameters maintained in the maintenance plan.
Comment: The Scheduling List shows scheduled calls with assigned call dates. Each call has its own system status with scheduling type. The first call has the type New Start with status Hold.
When you want to create a planned order for the first time before reaching the call date, you can use the function Release Call.
· Flag the first row in Scheduling List.
· Choose Release Call.
· Choose Save and confirm all the messages if appear.
To check the automatically created preventive maintenance order, follow these steps:
1. Open Schedule Maintenance Plan again.
· Enter the maintenance plan number.
· Choose Enter.
· In the Scheduling List, choose the first line you have called.
· Choose Display Call Object.
· Note the maintenance order number.
	The first checking step of maintenance plan has been scheduled.
The preventive maintenance order is created automatically.
The notification of activity report is created automatically.
The material reservation is created automatically if stock material is needed.
	


Result
The maintenance plan has been scheduled.
Hint: If you want to use mass scheduling instead of manually scheduling the maintenance plan, you can use the tile Mass Schedule Maintenance Plans (IP30H) with the business role Maintenance Planner.
To start mass scheduling, you must have entered a start date in the maintenance plan or have scheduled the maintenance plan once.
[bookmark: d2e3150][bookmark: _Toc51256777]Order Processing
[bookmark: unique_30][bookmark: _Toc51256778]Release Preventive Maintenance Order and Print to Job List
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
The maintenance order is used to collect all costs for a maintenance task and to debit the cost center that incurred the costs using the settlement functions in the CO module (Controlling).
Hint: Before or after you release the maintenance order, you can use tile Schedule Material Availability Check with business role Maintenance Planner to run material ATP check for daily check. If parts are missing, the maintenance order will show system status MSPT Material shortage when you check the maintenance order.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad is displayed.
	

	2
	Open Display Order or Notification in Information Center
	Open Manage Orders and Notifications in Information Center (W0019).
	The Order and Notification Information Center screen appears.
	

	3
	Search Created Maintenance Order
	Follow these steps:
1. In the Lists area, choose Order List > Default (x) in the row of maintenance orders.
· Choose the row of created preventive maintenance order.
· Choose Refresh if necessary.
	
	

	4
	Material Availability Check
	Choose Material Availability Check.
	If parts are missing, the maintenance order will show system status MSPT Material shortage. You can still release the maintenance order and replenish later. In this case, you may refer to the chapter Initializing Material Stock for replenishment.
	

	5
	Release Order
	If the order is not released, choose Set Order Status > Release .
	The maintenance order is released.
	

	6
	Print Order
	Select a released order number and then choose Print Order.
In the popup screen, choose OK to print all shop papers in the list.
	The maintenance order and related documents are printed to the job list. Only printed maintenance orders will be displayed in the next step in confirmation list.
If multiple orders are selected for printing, a popup screen appears with two options:
1. Use default shop papers
· Select shop papers
The user can select one of the options and proceed.
	


[bookmark: unique_31][bookmark: _Toc51256779]Print Job Card
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
After the maintenance order is released, the maintenance technician may print the job card. The job card contains maintenance order details, such as operations, time ticket, completion confirmation slip, object list and, and so on.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as Maintenance Technician.
	The SAP Fiori launchpad is displayed.
	

	2
	Open Display Job List (W0016)
	Open Display Job List (W0016).
	The Job List screen appears.
	

	3
	Choose Maintenance Order in Job List.
	Follow these steps:
1. In the Job List – Default (x) view results: choose the line of released preventive maintenance order.
Comment: If the job list does not contain yours, please choose Define New Query.
· Choose Next twice.
· Then Finish to create a new query without date limit.
· In the New Query (x) tab, you can find your job list.
	The details of the selected job show in the lower part of the screen.
The maintenance order number shows in the References section.
	

	4
	Display Job Card
	Choose Display Job Card.
	The Job Card Preview screen appears.
	

	5
	Print Job Card
	Follow these steps:
1. Choose Print.
· Set the printer parameters and print the job card as you want.
	The job card is printed.
	


[bookmark: unique_32][bookmark: _Toc51256780]Confirm Preventive Maintenance Order
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
After finishing the preventive maintenance, we have to confirm the order to record the real work time and the spare parts consumption. The data would be used for follow-up cost evaluation.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as Maintenance Technician.
	The SAP Fiori launchpad is displayed.
	

	2
	Open Confirm Jobs
	Open Confirm Jobs (EAMS_WDA_CONF_OIF) (W0020).
	The confirmation screen displays.
	

	3
	Choose Order Number
	1. In the Confirmation List-Default(X) area, choose the row of created Preventive Maintenance Order number.
Comment: If the confirmation list does not contain yours, follow these steps:
· Choose Define New Query.
· Choose Next twice
· Choose Finish to create a new query without date limit. In the New Query (x) tab, you can find your confirmation list.
· Choose Edit and Confirm.
	The Confirm Job screen displays.
	

	4
	Confirm the Times
	On the Operation Data tab, Details area, Confirmation Data tab, choose Get Remaining Work.
Make the following entries if needed:
1. Actual Work: For example: 5 (5 hours)
Comment: Working time only
· Start Date: <Date>
· Start Time: <Time>
· End Date: <Date>
· End Time: <Time>
· Final Confirmation: X
Comment: This means that the operation is finally completed.
· No Remaining Work: X
Comment: This means that there is no remaining work for this operation.
	
	

	5
	Confirm the Material Used
	In the confirmation of Material Used area, if the material is maintained in the maintenance order, choose Get Remaining Materials.
Check and make the following entries:
Material: <Material> For example, SP005
Quantity: <Quantity>
Plant: 1010
Storage Location: 101B
If the material is maintained in the related task list operation, the generated maintenance order will have material assigned.
You may check the reservation number here.
	
	

	
	Get measuring point
	If you know the measuring point, enter it, or choose Get Measuring Points from Object List. You will view measuring points created for the technical objects. Enter the reading against the required measuring point:
1. Reading: <Counter Reading>
· Date: <Counter Reading Date>
· Time: <Counter Reading Time>
	
	

	
	Save the order
	Choose Save.
	The maintenance order is confirmed.
Note down the number of your order for following steps.
	


[bookmark: unique_33][bookmark: _Toc51256781]Create Follow-On Order
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
You can use this function to create maintenance orders as follow-on orders for an order or order operation. When you create a follow-on order, you create a relationship to the reference order or operation. You can display this relationship in the document flow.
You can create follow-on orders directly from Fiori tile or when you change or display an order.
You can display the relationship between the preceding order and the follow-on order in a hierarchical structure using the document flow.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad is displayed.
	

	2
	Search for Confirmed Preventive Maintenance Order
	Follow these steps:
1. Choose Search in the upper right area of the launchpad.
· In the drop down list of Search In, choose Maintenance Orders.
· Fill in the field Search In: Maintenance Orders with order number which is noted in the previous step.
· Choose Search.
	The system displays the found maintenance order in the list of results.
	

	3
	Choose Your Preventive Maintenance Order
	Choose Change Maintenance Order in the Results view.
	The Change Preventive Maintenance: xxxxxxx screen appears.
	

	4
	Created Follow-on Order
	On the Change Preventive Maintenance: xxxxxxx page, choose Additional Functions > Create Follow-On Order .
Or you can follow these steps:
1. Choose Operation Data tab.
· Right-click on the operation entries.
· Choose Create Follow-On Order from the context menu to copy the operations.
	The Create Order screen displays.
	

	5
	Maintain Follow-On Order Parame-ters
	Make the following entries:
1. Order Type: Maintenance Order YBA1
· Priority:
· Technical Object: <Technical Object>
Comment: Use the technical object you used in previous step for Preventive Maintenance Order.
· Assembly:
· Planning Plant: 1010
· Business Area:
In the Create by Copying area, make the following entries:
1. Order / Operation: <Preventive Maintenance Order / Operation number>
Comment: Please keep the default values
· Create Follow-On Order: X
You may check the following options to copy the relevant data from original preventive maintenance order. For this testing, please keep the default values.
· Operations:
· Components:
· Relationships:
· Document Links:
· Settlement Rules:
· Order Descriptions:
· Choose Continue.
	The Create Maintenance Order: %00000000001 screen displays.
	

	
	Maintain the General Data of the Follow-On Order
	On the General Data tab, make the following entries:
1. Description: <Description>
· Priority: <Priority>
· Required Start:<Start Date>
· Required End:<End Date>
· Assembly:
· System Condition: <System Condition>
· Choose Operation Data tab.
	The Operation Data tab displays.
	

	
	Maintain the Operation Data of the Follow-On Order
	On the Operation Data tab, make the following entries:
1. Description: <Operation Description>
· Work: <Work time>
· Number of Capacities: <Number of Capacities>
· In the Details: Operation xxxx section, choose Material tab. Switch Materials to Standard view.
Make the following entries:
1. Material: <Material> for example: SP001
· Quantity: <Quantity> for example: 1
	
	

	
	Save the follow-on order.
	Choose Check Entries. Choose Save.
	The follow-on order is saved. A left arrow flag represents follow-on order.
You can check the follow-on order in Display Maintenance Order with menu.
You can also check by going to Display Document Flow (IW12) > Follow-On Orders.
	


Result
The follow-on corrective maintenance order is created. You can continue testing the following business process for the follow-on order:

	Process
	Business Condition

	Corrective Maintenance (BH1)
Release Maintenance Order
Print Job Card
Confirm Maintenance Order
Show Costs on Maintenance Order
Technically Complete Maintenance Order
	A follow-on corrective maintenance order is created.


[bookmark: unique_34][bookmark: _Toc51256782]Show Costs on Preventive Maintenance Order
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
The planned and actual costs are displayed here.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad is displayed.
	

	2
	Access the SAP Fiori app
	Open Find Maintenance Order (F2175).
	The Maintenance Order screen displays.
	

	3
	Search Confirmed Maintenance Order
	On the Maintenance Order screen, search for your confirmed order either by plain text in Search field or via applying some filters. For example:
1. Order Type: YBA2
· Technical Object: <Technical Object ID>
· Order Status: Released
· Choose GO.
· Choose the order line that you confirmed in the previous step.
	
	

	4
	Review Costs
	Follow these steps:
1. Choose the Costs tab.
· Check the costs.
	The preventive maintenance order cost is reviewed.
	


[bookmark: unique_35][bookmark: _Toc51256783]Technically Complete Preventive Maintenance Order
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
If an order is executed, it must be completed in the system to be dealt with. In the Plant Maintenance module, there are two types of completion, technical completion and business completion.
Technical completion shows that an order was technically successful (or can be seen as technically completed by Plant Maintenance).
The following process shows how technical completion works.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad is displayed.
	

	2
	Open Display Order or Notification in Information Center
	Open Manage Orders and Notifications in Information Center (EAMS_WDA_ONL_IC_OVP) (W0019) .
	The Order and Notification Information Center screen displays.
	

	3
	Search Confirmed Maintenance Order
	In the Lists area, choose Order List – Default (x) in the row of Maintenance Orders.
Choose the row of confirmed Preventive Maintenance Order.
	
	

	4
	Set Complete (Technically) Status.
	Choose Set Order Status > Complete (Technically) >.
On the Complete (Technically) screen, make the following entries:
1. Reference Date: <Date>
· Reference Time: <Time>
· Choose OK.
	The preventive maintenance order is technically completed.
	


[bookmark: unique_36][bookmark: _Toc51256784]Review Document Flow of Preventive Maintenance Order
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
You can display the document flow of the order in a hierarchical list. You can then select the order in the document flow and choose Follow-On Orders. The system displays the relationship between the preceding order and the follow-on order. This list displays at most one level above and one level below the selected order. In other words, only the orders directly preceding and directly following the order that you selected are displayed.
If you have created follow-on orders for more than one order operation, the system displays all the follow-on orders that have been created for the selected order or its operations.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad is displayed.
	

	2
	Open Display Maintenance Order
	Open Display Maintenance Order (W0033).
Fill in the created preventive maintenance order number. Or use the Value Help to search for the order. Select this result item to return with the result.
Choose Continue.
	The Display Preventive Maintenance: xxxxxxx screen appears.
	

	3
	Display Document Flow
	On the Display Preventive Maintenance: xxxxxxx page, choose You can also -> Display Document Flow (IW12).
	The Display Document Flow screen appears.
	

	4
	Review the Follow-on Order
	Choose Follow-On Orders.
	The follow-on order is reviewed.
	


[bookmark: unique_37][bookmark: _Toc51256785]Review Asset Maintenance Object Pages
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this activity, you review the different objects pages available for different roles in Enterprise Asset Management.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as Maintenance Planner.
Note You can use any of the maintenance roles from the sections above.
	The SAP Fiori launchpad displays.
	

	2
	Start Search
	Choose Search in the upper right area of the launchpad.
	
	

	3
	Set Search Criteria
	In the dropdown list, choose Equipment, for example: <210100001>.
	
	

	4
	Tailor the Result Display
	Below the search line, choose a symbol (for example, filter, display as table, sort, and so on) to filter the results list.
	The result list is filtered according to your selection.
	

	5
	Review Object Page
	Review overview information for the equipment via the Object Page.
	
	

	6
	Repeat Steps
	Repeat steps 1 to 5 for any other role in this test script and any other object offered in the search function.
For example:
1. Notification
· Order
· Order Confirmation
	
	


[bookmark: d2e3935][bookmark: _Toc51256786]Appendix
[bookmark: unique_40][bookmark: _Toc51256787]Maintenance Planning Overview
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
Maintenance Planning Overview (F2828) provides a role-based and personalized entry page for maintenance planners to monitor the progress of various maintenance activities that impact asset availability and reliability. It also provides maintenance planners with clear overview of the current situations in their area of responsibility and enables quick actions.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad is displayed.
	

	2
	Open Maintenance Planning Overview
	Open Maintenance Planning Overview (F2828).
	The Maintenance Planning Overview screen displays.
	

	3
	Search for Notifications and Orders
	Set Reference Period or Reference Date on the upper part of the screen.
You can display outstanding notifications by choosing Priority, Activity or Notification Type in the Notifications for Screening card.
You can also check Missing Components, Overdue Orders, Orders for Completion, Orders for Planning, Purchase Requisitions and so on in other cards.
You can find relevant applications on the Quick Links card on the lower left corner of the screen.
	The notifications filtered by different criterias will be shown as bar chart in Notifications for screening card. You can choose different segments of the bar to see more details.
	


[bookmark: unique_41][bookmark: _Toc51256788]Process Integration
The process to be tested in this test script is part of a chain of integrated processes.
[bookmark: unique_42][bookmark: _Toc51256789]Preceding Processes
You may first have completed the following processes and conditions before starting with the test steps:
	Process
	Business Condition

	MDS: Create New Open MM Posting Period (BNZ)
	ScopeItem_BusinessCondition


[bookmark: unique_43][bookmark: _Toc51256790]Succeeding Processes
After completing the activities in this test script, you can continue testing the following business processes:
	Process
	Business Condition

	Period-End Closing - Maintenance Orders (BF7)
	A maintenance order has been technically completed.


[bookmark: unique_20][bookmark: _Toc51256791]Schedule Maintenance Plan
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
When you schedule your maintenance plan for the first time, you trigger the maintenance cycle. The system uses the scheduling information in the maintenance plan to calculate the due date of the maintenance call object.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as Maintenance Planner.
	The SAP Fiori launchpad displays.
	

	2
	Open Schedule Maintenance Plan
	Open Schedule Maintenance Plan (IP10).
	The Schedule Maintenance Plan: Initial screen displays.
	

	3
	Search Maintenance Plan
	Make the following entries and choose Enter.
1. MaintenancePlan: <Maintenance Plan num-ber>
Please use the single cycle plan (perfomance based) created in the previous step.
	The Schedule Maintenance Plan: Single Cycle Plan <Maintenance Plan number> screen displays.
	

	4
	Schedule Maintenance Plan
	1. Choose Start.
· On the Start Date screen, enter a start date. For example, enter current date.
· Start of cycle:<Counter reading >
Comment: If a start counter reading was entered during the maintenance plan creation, the system will propose that reading as the start counter reading. It can be changed to a different reading as well, if required.
· Choose Continue.
You will receive an overview of scheduled calls with plan date and call date of a scheduled call.
The overview is based on your start of cycle counter reading, annual estimate (entered against respective measuring point), and scheduling parameters that are maintained in the maintenance plan.
Comment: The scheduling list shows scheduled calls with assigned call dates. Each call has its own system status with scheduling type. The first call has the type New Start with status Hold.
· When you want to create a planned order for the first time before reaching the call date, you can use the function Release Call.
Flag the first row in the scheduling list.
Choose Release Call.
· Choose Save and confirm all the messages that appear.
To check the automatically created preventive maintenance order:
1. Open the schedule maintenance plan again.
· Enter the maintenance plan number.
· Choose Enter.
· In the Scheduling List, choose the first line you have called.
· Choose Display Call Object.
· Note the maintenance order number.
	The first checking step of the maintenance plan has been scheduled.
The preventive maintenance order is created automatically.
The notification of activity report is created automatically.
The material reservation is created automatically if stock material is needed.
	


Result
The maintenance plan has been scheduled.
Hint: If you want to use Mass Scheduling instead of manually scheduling maintenance plans, you can use tile Mass Schedule Maintenance Plans (IP30H) with business role Maintenance Planner.
To start mass scheduling, you must have entered a start counter reading in the maintenance plan or scheduled the maintenance plan once.

Typographic Conventions
	Type Style
	Description

	Example
	Words or characters quoted from the screen. These include field names, screen titles, pushbuttons labels, menu names, menu paths, and menu options.
Textual cross-references to other documents.

	Example
	Emphasized words or expressions.

	EXAMPLE
	Technical names of system objects. These include report names, program names, transaction codes, table names, and key concepts of a programming language when they are surrounded by body text, for example, SELECT and INCLUDE.

	Example
	Output on the screen. This includes file and directory names and their paths, messages, names of variables and parameters, source text, and names of installation, upgrade and database tools.

	Example
	Exact user entry. These are words or characters that you enter in the system exactly as they appear in the documentation.

	<Example>
	Variable user entry. Angle brackets indicate that you replace these words and characters with appropriate entries to make entries in the system.

	EXAMPLE
	Keys on the keyboard, for example, F2 or ENTER.
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